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The Autodesk Animation Player allows you to play animations created using Autodesk Animator, 
Autodesk 3D Studio, or Autodesk Animator Pro.
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File Menu Commands

New Script
Opens a new script, starts the Edit Script dialogue.
If a script is open with unsaved changes, you are given a chance to save it.

Load Script
Opens an existing animation script file.

Edit Script
Starts the Edit Script dialogue, which lets you add, delete, copy, and paste animation files in a script.

Save Script
Saves changes to the current animation script.
Save can only be used when a script has been opened.

Save Script As
Allows you to save an existing script with a new name, leaving the original unchanged. Save As can 
only be used when a script has been opened.

Related topics:
Creating a Script
Editing Scripts

Open Animation
Opens an existing animation file.
Several file formats can be opened:

An Autodesk Animator animation. 
An Autodesk Animator Pro animation.
An Autodesk 3D Studio animation.
A Windows Device Independent Bitmap

(DIB).

Get Sound
Adds sound to an animation. To be used after Open Animation. Cannot be used with scripts.
Use the Edit Script Command to add sound to scripts.
Related topics:
Using Sound
Scripting Animations

Anim Settings
Lets you adjust an animation's playback speed, duration, sound, and other characteristics.
Related topic:
Animation Settings

Convert Anim
Converts animation colors for optimal playback under Microsoft Windows.
Creates a new animation with the converted colors.
Cannot be used with scripts or DIBs.
Related Topic:
Animation Colors



Exit
Closes the current file and exits Autodesk Animation Player. If an unsaved script is open, Autodesk 
Animation Player lets you save it before exiting.



Edit Menu Commands

Copy
Copies the image of the current frame to the clipboard. Once the image is copied, it can be pasted into
other documents.



Options Menu Commands

The items checked in the Options Menu are applied to an animation when Autodesk Animation Player 
opens the file.

Load in Memory
Animations load into memory when opened, resulting in faster playback.

Loop Frame
The last image in a DIB is used as a transition frame between the end and beginning of an animation. 
Use this option for non-Autodesk animation formats such as .rle.

Full Screen
Animations play back in full-screen VGA mode. Animations smaller than 320 by 200 use the 320 by 
200 low resolution mode of the VGA.

Hide Animation
Animations do not appear onscreen until they are played.

Color Cycling OK
Reserve Windows palette colors for color cycling as the colors change. This option is active by default.
Turn it off if your animation is losing colors on playback.
Related Topic:
Animation Colors

Use All Colors
Reserve all available Windows palette colors for color cycling when the animation is opened. Use this 
option if your animation involves palette animation and if it uses fewer than 236 colors. 
Related Topic:
Animation Colors

Resize Window
Resize the animation window to exactly fit an animation when it is opened. The state of this option is 
set to the last setting when the Animation Player is started.



Frame Control Commands

The buttons , 

, 

, and 

 on the Menu Bar are executed immediately when you click on them.

Backup Frame
Moves the animation to the previous frame.
Moves from the first frame to the last.
Keyboard shortcut: the left arrow key.

Stop
Stops the animation.
Keyboard shortcut: the up arrow key.

Forward Frame
Moves the animation to the next frame.
Moves from the last frame to the first.
Keyboard shortcut: the right arrow key.

Play/Pause
If the animation is not playing, the animation is started.
If the animation is playing, the animation is paused.
Keyboard shortcut: the down arrow key. 



Creating a Script

An Autodesk Animation Player script is an ASCII text file containing a list of animations or DIBs to be 
played in the order they are listed. 

You can create a script using either a standard text editor or the New Script command in Autodesk 
Animation Player.

You can edit a script with a text editor or by using the Edit Script command in Autodesk Animation 
Player when a script is open. (See Editing Scripts.)

The following are guidelines to follow if you create your own ASCII script outside the Autodesk 
Animation Player editor: 
 

List a single file on each line, along with any nondefault playback settings.

The first thing on a script line is the name of the file to be played. If the file has an extension, it must
be included as part of the name. Follow the file name with playback codes to indicate nondefault 
playback settings.

If a line becomes too long, continue it by placing a back slash character at the end of the line.

Animation settings codes change the playback settings from the Autodesk Animation Player 
defaults. Each option consists of a dash (-), followed by a single letter identifying the option, 
followed by any arguments the option uses. You may place a space between the option and the 
argument, or not. You must put a space between each of the option's arguments, and between the 
last argument and the next option.

For example: 
D:\PLAYER\BIKER.FLC -L4:35 -F

Note: Playback option codes appear without dashes or arguments when the script file appears in 
the Autodesk Animation Player Edit Script dialogue.



Animation Settings Codes

The options used in scripts are as follows:

-N [sound-string [device]]
Change the sound for the script. Sound-string is the sound filename or media location, and device is 
the sound playback device. See Using Sound for more details on sound. If the -N option is missing, 
sound is turned off. If sound-string is missing, the sound already playing continues. Defaults to no 
sound.
-R sound-repeat
Set the number of times the sound repeats. The sound is not repeated if this option is missing. Sound-
repeat can be 0 or Forever, either of which causes the sound to repeat until the animation ends. 
Defaults to 1.
-D delay
Delay the start of a sound from the beginning of an animation. You can use negative numbers to cause
a sound to start before an animation. Defaults to 0.
-L loops
Set the number of times an animation is to repeat. You can state partial repeats in frames by following 
the loop count by a colon (:) and the number of frames in the last loop (e.g., 3:20 and 0:5). A value of 
Forever causes the animation to loop until an external event intervenes. A value of Sound loops the 
animation until the current sound finishes. A value of Sound:nn also loops the animation until the 
sound finishes, but then continues after the sound is finished until frame nn is displayed. For example, 
Sound loops until the sound finishes and ends the animation on the frame displayed when the sound 
finishes. Sound:0 loops until the sound ends, but continues through the loop until the end of the 
animation is reached. Sound:10 continues after the sound is finished until frame 10 is displayed and 
then ends the animation. Defaults to 1.
-S speed
Set the speed of the animation. Defaults to value designed in the animation.
-P pause
Set the length of time the animation pauses when all loops are completed. Defaults to 0.
-M
Load animation into memory. Defaults to playback from disk.
-F
Play animation on full screen. Defaults to playback in a window.
-E
No loop frame; last frame does not contain the deltas between the end and beginning of the animation.
This code is irrelevant for Autodesk animations. Corresponds to Loop Frame Present item in the 
Animation Settings dialogue.
-C
Turn Color Cycling OK off; do not reserve Windows colors for palette animation. Mutually exclusive 
with -A.
-A
Reserve entire available Windows palette for palette animation. Mutually exclusive with -C.
-I fade_string fade_duration
Add a transition to the animation. Defaults to no transition (cut). The fade_string can be cutfrom, 
fromblack, fromwhite, cutto, toblack, or towhite. The fade_duration can range from 250 
milliseconds to 10000 milliseconds (.25 seconds to 10 seconds).



Using Sound

You can associate sound with animations in scripts, or with a single animation in memory. Use the Get
Sound... option of the File menu to associate sound with an animation or Windows DIB while it is 
loaded.

Use the Get Sound button in the Edit Script dialogue box to add sounds to scripted animations.

When you select a sound, you must also select the sound device. Autodesk Animation Player can play
the following types of sound:

waveaudio - digitized sound or waveAudio
cdaudio - audio from a CDROM
videodisc - audio from a videodisc player
sequencer - MIDI sound



Digitized Sound

Digitized sound, also called wave audio, is sound that has been recorded in digital format.

Select digitized sound by specifying waveaudio as the sound device and selecting a file containing 
the digitized sound to be played. Usually these files end in .wav.



CDROM Audio

CDROM Audio is sound played from a compact disc on a CDROM player.

Select CDROM audio by specifying cdaudio as the sound device and entering the track to be played 
in the Filename field. Enter the following parameters instead of a file name:

from pos to pos

Pos gives a position on the CDROM disk. Positions are given in tracks, minutes, seconds, and frames 
in the format tt:mm:ss:ff. You can leave off trailing zeros. For example:

from 1 to 2 plays all of track 1.
from 3 to 3:3 plays three minutes of track 3.
from 5 to 6:2 plays all of track 5 and 2 minutes of track 6.



Videodisc Audio

Videodisc players are usually used for images and sound, but Autodesk Animation Player allows you 
to select a portion of a videodisc to be played along with an animation.

Select videodisc audio by specifying videodisc as the sound device and entering the start and stop 
frames to be played instead of a file name in the Filename field:

from pos to pos

Pos gives the position on the videodisc in frames. Always give the to argument to insure that the end 
of the sound is known. If from is not given, the sound starts from the current position.

In this case, position is a time in hh:mm:ss format. Your videodisc player may display position in this 
format, or it may display position as a frame number. To convert from frame numbers to time, divide by
30 to get seconds, and then convert to hh:mm:ss format. The from position must be at least 1 second. 
For example, enter

from 0:0:1 to 0:4:0

to play 4 minutes on the disc.



MIDI Sound

MIDI sound is a recording of notes and instruments that is played on electrical instruments or 
synthesizers.

Select MIDI sound by specifying the sequencer sound device and choosing a file containing the 
recorded notes and instrument data. Usually these files end in .mid or .rmi.



Animation Settings

Animations have characteristics that affect how they play back. Some settings, such as number of 
frames and speed, are designed into the animation when it is created. Others Autodesk Animation 
Player assigns by default. You can adjust playback settings in Autodesk Animation Player either from 
the Anim Settings... entry of the File menu or by pressing the Settings button in the Edit Script 
dialogue.

The Speed, Loops, and Duration settings control the speed and length of an animation sequence. 
These three settings are related since the duration of an animation is determined by the speed and the
number of times the animation is repeated (loops).

The Lock buttons to the left of these settings are used to fix one of the three values as the other two 
change. If you change the setting that is locked, it unlocks, and either Speed locks if you are changing 
Loops or Duration, or Loops locks if you are changing Speed.

Load in Memory
Causes the entire animation to load into memory when you open it. This can take a significant amount 
of time, but the animation plays faster once it is loaded.

Full Screen
Causes the animation to use the entire screen when playing. If you are playing an animation smaller 
than 320 pixels by 200 pixels on a VGA, the VGA changes to this resolution before playing the 
animation.

Loop Frame Present
Only applies to sequences of Windows DIBs. It indicates that the last DIB in the sequence is a loop 
frame, or transition, to the first DIB in the sequence. If this is not the case, toggle this option off.

Color Cycling OK
Controls palette animation under Windows. If it is checked, colors are reserved for cycling as they are 
changed. See Animation Colors for more details.

Use All Colors
Controls palette animation under Windows. If it is checked, colors are reserved for cycling when the 
animation is loaded. See Animation Colors for more details.

Jiffies
Controls the units used to display and enter speed values. If it is highlighted, the speed unit is jiffies.

Frames per Second
Controls the units used to display and enter speed values. If it is highlighted, the speed unit is frames 
per second.

Speed
Sets the speed of the animation.

Loops
Loops sets the number of times an animation repeats. You can also specify a partial repetition of an 
animation by following the number of loops with the number of frames in the partial repeat. For example, 
3:20 indicates 3 full loops of the animation followed by 20 frames, while 0:5 specifies only 5 frames of the 
animation. You can also set the number of full repeats to Sound, which causes the animation to repeat 
until the sound finishes. If you specify a partial repeat (e.g., Sound:1), the animation stops at the 
specified frame. Sound:0 causes the animation to loop until the sound finishes, then complete the final 



loop, stopping on the last frame of the animation.

Duration
Sets the duration of the animation in minutes:seconds:milliseconds.

Repeat Sound
Sets the number of times the sound is repeated. Forever means the sound repeats until the animation
finishes.

Delay Sound
The time in seconds to delay the sound from the start of the animation. If the time is negative, the 
sound starts before the animation starts.

Pause at End
Specifies the length of time in seconds that the animation pauses at the end of all its repetitions. The 
final frame of the animation is displayed during the pause.

Transitions
You can add transitions to the beginning or the end of an animation by pressing the Transitions 
button. A dialogue appears that lets you enter the starting or ending transition and duration.

You can add fade transitions to smooth the transition between animations. A fade is a color cycling 
effect, and the Color Cycling OK option must be checked for a fade transition to perform correctly. 
(See Animation Colors.)



Editing Scripts

A script    consists of a list of animations. The Edit Script dialogue is provided for editing scripts. You 
can also edit animation settings from this dialogue, by clicking on the Settings button.

The list of animations is displayed on the left side of the Edit Script dialogue. On the right side of the 
dialogue is a set of boxes for selecting a new animation to be put in the list. The new animation is 
inserted after the currently selected animation.

The set of buttons under the list of animations lets you edit the script. Cut deletes the currently 
selected lines in the list. Copy copies the lines to the Windows Clipboard. Paste pastes lines from the 
Clipboard after the currently selected line. Clear deletes the selected lines, but does not place them in 
the Clipboard as Cut does. Undo undoes the last edit.

Use the following keyboard alternatives as shortcuts for the editing buttons:

SHIFT+DEL Cut
CTRL+INSERT Copy
DEL Clear
SHIFT+INSERT Paste

The buttons on the right side of the dialogue box are:

Exit
Ends the dialogue. This does not save the script.

Test
Performs a test of the script. The test begins at the selected entry in the list.

Save
Saves the script. If the script has never been saved, this option invokes the Save Script dialogue.

Settings
Displays the Animation Settings dialogue and allows you to adjust the playback options of the selected
animation.

Get Sound
Changes the dialogue so you can locate a sound to associate with the selected animation. See Using 
Sound for details on selecting sounds.

You can choose to continue playing the sound associated with the previous animation by pressing the 
Continue button. The Off button turns off sound for the selected animation.

When you click on the Get Sound button, it changes to a Cancel button. Pressing Cancel reverts the 
Edit Script dialogue back to animation selection mode, canceling changes you've made to sound.



Animation Colors

Windows requires 20 colors for system use, which reduces the available colors for animations from 
256 to 236. Normally this is not a problem, because Windows matches colors in order to display an 
animation properly.

However, there are circumstances in which color matching is not possible. If your animation involves 
palette animation (that is, if color registers change color), Windows maps unavailable colors to black. 
Palette animation is typically used for wipes, dissolves, fades, and color cycling.

Windows also remaps color changes between animations in scripts, unless the Use All Colors option 
is checked in the Animation Settings dialogue. Checking this option can improve the transition 
between animations in scripts. Use All Colors can cause colors to be lost if the animation uses more 
than 236 colors.

Autodesk Animation Player can convert an animation's colors to fit the Windows color model. This 
process removes any colors from the palette that are not actually used in the animation, and reduces 
the number of colors used to 236 if more than that are used in the animation. This change prevents 
Windows from dropping or changing colors. To convert an animation's colors, load the animation and 
select Convert Anim... from the File menu. 



Authoring Hints

Here are a few things to keep in mind as you create animations for playback under Autodesk 
Animation Player for Windows:

Colors in Animations
Windows restricts an animation playing in a window to 236 colors. Autodesk Animation Player tries to 
overcome this restriction (see Animation Colors), but for best results, design your animation with fewer
than 236 colors.

Colors in Scripts
The transition between animations in a script may have a short period where the colors are incorrect. 
This is usually caused when Windows remaps the colors for two different animations. You can alleviate
this problem by checking the Use All Colors option in the Animation Settings dialogue. (Also See 
Animation Colors.)

Playback Speed
Playing animations under Windows requires translation from Autodesk Animator format to Windows 
format, which decreases playback speed. In designing animations, try to minimize changes from one 
frame to another. For example, full-frame dissolves do not play well. 

When you play full-screen animations smaller than 320 by 200 on a VGA, this translation is not 
required, and you can achieve better performance.

Transitions
Fades can help smooth the transition between animations. A fade is a color cycling effect, and the 
Color Cycling OK option must be active for a fade transition to perform correctly.    Use All Colors 
should also be active when you use fades. (See Animation Colors and Animation Settings.)



DIB - Windows Device Independent Bitmap. It may be compressed or uncompressed.



MIDI - Musical Instrument Digital Interface. A standard way to connect electrical musical instruments.



PALETTE ANIMATION - In Autodesk Animator and Autodesk Animator Pro, palette animation occurs 
when the colors in the palette change over time.


